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Load Test :

Load Tests are end to end performance tests under anticipated mmodoatl. The objective of such
tests are to determine the response times for various titiwaldriansactions and business processes and
ensure that they are within documented expectations (or Serviet Agreements - SLAs). Load tests
also measures the capability of an application to functiorecity under load, by measuring transaction
pass/fail/error rates.

Load Tests are major tests, requiring substantial input froraubi@ess, so that anticipated activity can
be accurately simulated in a test environment. If the projed pdst in production then logs from the
pilot can be used to generate ‘usage profiles’ that can be used as partesting process, and can even
be used to ‘drive’ large portions of the Load Test.

Load testing must be executed on “today’s” production size datadras@ptionally with a “projected”
database. If some database tables will be much larger inrsomths time, then Load testing should
also be conducted against a projected database. It is importastithatests are repeatable, and give
the same results for identical runs. They may need to be execuzdl $imnes in the first year of wide
scale deployment, to ensure that new releases and changes isa@aiabado not push response times
beyond prescribed SLAs.

What is the purpose of a Load Test?

The purpose of any load test should be clearly understood and documertedi tést usually fits into
one of the following categories:

Quantification of risk. - Determine, through formal testing, the likelihood that systenopedance
will meet the formal stated performance expectations of stadkefsol such as response time
requirements under given levels of load. This is a traditional Quasisurance (QA) type test. Note
that load testing does not mitigate risk directly, but through idestiilbn and quantification of risk,
presents tuning opportunities and an impetus for remediation that will mitiglate ri

Determination of minimum configuration. - Determine, through formal testing, the minimum
configuration that will allow the system to meet the formaltest performance expectations of
stakeholders - so that extraneous hardware, software and theéatess@ost of ownership can be
minimized. This is a Business Technology Optimization (BTO) type test.

Assessing release readiness bignabling you to predict or estimate the performance characteridtic

an application in production and evaluate whether or not to addressnpamt@ concerns based on
those predictions. These predictions are also valuable to thehetd&rs who make decisions about
whether an application is ready for release or capable of handling fyrtawth, or whether it requires a
performance improvement/hardware upgrade prior to release.



What functions or business processes should be load tested?

The most frequently used transactions have the poteﬁtial

High frequency transactions to impact the performance of all of the other transactians
if they are not efficient.

The more important transactions that facilitate the corg
objectives of the system should be included, as failure
under load of these transactions has, by definition, the
greatest impact.

At least one READ ONLY transaction should be included,
Read Transactions so that performance of such transactions can be
differentiated from other more complex transactions.
At least one update transaction should be included so|that
Update Transactions performance of such transactions can be differentiated
from other transactions.

1%

Mission Critical transactions

Load Testing Process

Identify the performance-critical scenarios.

Identify the workload profile for distributing the entire load among the key
scenarios.

Identify the metrics that you want to collect in order to verify them against your
Performance objectives.

Design tests to simulate the load.

Use tools to implement the load according to the designed tests, and capture the
metrics.

Analyze the metric data captured during the tests.

Load Test Terminologies:

Scenarios are anticipated user paths that generally incorporate multiplecaipgh
activities. Key scenarios are those for which you have specifiorpgance goals, those
considered to be high-risk, those that are most commonly used, or thoseswgitificant
performance impact. The basic steps for identifying key scenarios are.



Metrics are measurements obtained by running performance tests as exmesaed
commonly understood scale. Some metrics commonly obtained through perfermanc
tests include processor utilization over time and memory usage by load.

Responsd¢ime is a measure of how responsive an application or subsystem di¢nta
request.

Throughput is the number of units of work that can be handled per unit of time; for
instance, requests per second, calls per day, hits per second, reports per year, etc.

Workload is the stimulus applied to a system, application, or component toasaraul
usage pattern, in regard to concurrency and/or data inputs. The wonktbades the
total number of users, concurrent active users, data volumes, asdctiran volumes,
along with the transaction mix. For performance modeling, you associate a workiload wi
an individual scenario.

Resource utilizationis the cost of the project in terms of system resourcespiiimary
resources are processor, memory, disk /O, and network I/O.

Scalability refers to an application’s ability to handle additional workloadhout
adversely affecting performance, by adding resources such as prooesswty, and
storage capacity.

Performance requirementare those criteria that are absolutely non-negotiable due to
contractual obligations, service level agreements (SLAS), or fixed busieeds. Any
performance criterion that will not unquestionably lead to a decision to dedtgaze

until the criterion passes is not absolutely requirednd therefore, not a requirement.

Performance-testing effort in your project context should include:

Project vision. Before beginning performance testing, ensure that you
understand the current project vision. The project vision is the foondédr
determining what performance testing is necessary and valuablesitRée
vision regularly, as it has the potential to change as well.

Purpose of the system.Understand the purpose of the application or system you
are testing. This will help you identify the highest-priority perfanoe
characteristics on which you should focus your testing. You will need to kreow t
system’s intent, the actual hardware and software archikedeployed, and the
characteristics of the typical end user.

Customer or user expectations.Keep customer or user expectations in mind
when planning performance testing. Remember that customer or ustctain



is based on expectations, not simply compliance with explicitly dstate
requirements.

Business drivers. Understand the business drivers — such as business needs or
opportunities — that are constrained to some degree by budget, schedwe, and/
resources. It is important to meet your business requirements oanineithin

the available budget.

Reasons for testing performance. Understand the reasons for conducting
performance testing very early in the project. Failing to do so madd to
ineffective performance testing. These reasons often go beyond af list
performance acceptance criteria and are bound to change or shifly @s the
project progresses, so revisit them regularly as you and your lezam more
about the application, its performance, and the customer or user.

Value that performance testing brings to the project. Understand the value
that performance testing is expected to bring to the project bgldtang the
project- and business-level objectives into specific, identdiabhd manageable
performance testing activities. Coordinate and prioritize thestvities to
determine which performance testing activities are likely to add value.

Project management and staffing. Understand the team’s organization,
operation, and communication techniques in order to conduct performatig tes
effectively.

Process. Understand your team’s process and interpret how that processsappl
to performance testing. If the team’s process documentation doesddiass
performance testing directly, extrapolate the document to include mparioe
testing to the best of your ability, and then get the revised documearmvad by

the project manager and/or process engineer.

Compliance criteria. Understand the regulatory requirements related to your
project. Obtain compliance documents to ensure that you have the cspecifi
language and context of any statement related to testing, as thimatitor is
critical to determining compliance tests and ensuring a compdiamtuct. Also
understand that the nature of performance testing makes it wirtonglbssible to
follow the same processes that have been developed for functional testing.



Project schedule. Be aware of the project start and end dates, the hardware and
environment availability dates, the flow of builds and releases| any
checkpoints and milestones in the project schedule.

Load Runner:
HP LoadRunnera tool for performance testing, stresses your entire application tteiaola
identify potential client, network, and server bottlenecks.

HP LoadRunner load tests your application by emulating an environmentdh mhitiple users
work concurrently. While the application is under load, LoadRunner aetyirmeasures,
monitors, and analyzes a system’s performance and functionality.

How LoadRunner Addresses the Performance Testing:

LoadRunner reduces personnel requirements by replacing human users with
virtual users or Vusers. These Vusers emulate the behavior of real users—
operating real applications.

Because numerous Vusers can run on a single computer, LoadRunner reduces the
amount of hardware required for testing.

The HP LoadRunner Controller allows you to easily and effectively control all the
Vusers—from a single point of control.

LoadRunner monitors the application performance online, enabling you to fine-
tune your system during test execution.

LoadRunner automatically records the performance of the application during a
test. You can choose from a wide variety of graphs and reports to view the
performance data.

LoadRunner checks where performance delays occur: network or client delays,
CPU performance, 1/0 delays, database locking, or other issues at the database
server. LoadRunner monitors the network and server resources to help you
improve performance.

Because LoadRunner tests are fully automated, you can easily repeat them as
often as you need.

Various Components of LoadRunner:

Vuser Generator:

Vuser Generator is the Script generation component of LoadRunner. This component hasmtwo m
things and are described below:



VusersIn the scenario, LoadRunner replaces human users with virtualanséusers. When you run a
scenario, Vusers emulate the actions of human users working with yoiwatippl While a workstation

accommodates only a single human user, many Vusers can run concumeatiyngle workstation. In
fact, a scenario can contain tens, hundreds, or even thousands of Vusers.

Vuser Scripts. The actions that a Vuser performs during the scenario are lobdn Vuser script.
When you run a scenario, each Vuser executes a Vuser script. Thes®iugey include functions that
measure and record the performance of your application’s components.

Controller. You use the HP LoadRunner Controller to manage and maintain your scetaimasthe
Controller, you control all the Vusers in a scenario from a single workstatio

Load Generator. When you execute a scenario, the Controller distributes each Yiubser scenario to
a load generator. The load generator is the machine that exdwuisser script, enabling the Vuser to
emulate the actions of a human user.

Performance analysis.Vuser scripts include functions that measure and recordnsysteformance
during load-testing sessions. During a scenario run, you can monitor the knatwdoserver resources.
Following a scenario run, you can view performance analysis data in reports and graphs

Working with LoadRunner

When testing or monitoring an environment, you need to emulate the true behavior of users on your
system. HP testing tools emulate an environment in which users concurrently workanessryour
system. To do this emulation, the human was replaced with a virtual user, aratheactions that a
Vuser performs are described in a Vuser script. The primary tool for creating3éugégs is the Virtual
User GeneratoluGen.

Vusers emulate the actions of human users by performing typical businessgeacgssir application.
The actions that a Vuser performs during the recording session are el scrb\Vuser script.

Using VuGen, you can run scripts as standalone tests. Running scriptsvVirGen is useful for
debugging as it enables you to see how a Vuser will behave and which enhancements neaddo be m

Steps for Creating Scripts:

VuGen enables you to record a variety of Vuser types, each suitedp#stieular load testing
environment or topology. When you open a new test, VuGen displays a corgplefethe supported
protocols.



Record a basic Vuser script

- =

Enhance/edit the Yuser
script

&V

Configure Run-Time settings

| —

Run the Wuser script in
stand-alone mode

| |

o

Integrate the Yuser Script

This window opens up as soon as you open the VuGen. You can select thel mioyoe application
and click ok. For most of the web application its Web (HTTP/HTML) Protocol

Open VuGen

To start VuGen, choose Start > ProgramsApp:_Name> for exampleLoadRunney > Applications >
Virtual User Generator from the Start menu.

To open an existing script, not in the recent list, click Open Existing Script.
To create a new script using a recent protocol, click the protocol in the

Recently used protocols list.
To create a new script in a protocol that is not listed, click New Vusgt.Sc

Choose File > Zip Operations > Import From Zip File ... to open an existipgfrom a zip archive.



HP ¥irtual User Generator - [Start Page]

: File Wew Tools ‘Window Help

Pt .| | [ @ StartRecord e B BE 23 | o |gb G EP G otasks | [FS)Echpt | Ry Tree | | 0 =
Start Page |

EA Virtual User Generator } . ﬁ

ScrHpts | Online Resources | What's Mew

Recenty used protocols

EF yeb (HTTR/HTML)

Mewr Yuser ScHpt...

% welcome to the Wirtual U

In a testing environment
physical machines with "
create load on a system
repeatable and predictak
transactions that enable
infarmation to help you |

Recenty used scripts
E COReg

Open Existing Script...

The Wirtual User Generat
| principle, As yvou wall th
WuGen records your acti

R T I R Y- B R T

Now click on the New Protocol Script and you will see the following Window. From thisowirydu
have to choose the protocol on which the application you are going to load test works.

VuGen provides a variety of Vuser technologies that allow you to emulate your system. Each
technology is suited to a particular architecture and results in a spgodiof Vuser script. For
example, you use Web Vuser Scripts to emulate users operating Web browsers. YR Ussdts to
emulate an FTP session. The various Vuser technologies can be used alone or togetate
effective load tests or Business Process Monitor profiles.



MNew ¥irtual User x|

Mew Single Protocol Script

Cateqaory : | Popular Protocols j

Dg; Microzoft Remote Desktop Protocol [ROF)

Oracle [2-Tier)

W Oracle NC&

&l SAPGLU

i@ wWeb [Click and Script)

31 'web Services

—wieb [Click and Script]
Ermulation of the communication between a web browser
and the web zerver at uszer-action level

k. Cancel

Now set the General options for VuGen.

For Example To set the environment-related options:
Select Tools > General Options and click the Environment tab.
To save the current script information for auto recovery, select the Save
AutoRecover Information option and specify the time in minutes between the
saves.
To set the editor font, click Select Font. The Font dialog box opens. Select the
desired font, style, and size and click OK. Note that only fixed size fonts (Courier,
Lucida Console, FixedSys, and so on) are available.

To use a comparison tool other than WDiff, select Use custom comparison tool
and then specify or browse for the desired tool.

Click OK to accept the settings and close the General Options dialog box.



Now Set the Recording Options for recording the user actions of the application uddestoa

HP ¥irtual User Generator - [monamel 2 - Web (Click and Script}]

! Fle Edit Yiew Insert  Yuser  Ackions | Tools | Window  Help
£l - | - ! @ start Record B % Performance Center Connection. ..

Start Page | noname12 - Web (Click and ser| o 2uality Center Connection...

]

: wusel_ini ‘_?:‘m Jifj Create Controller Scenario..
Action

@ vuzer_end H | Compare with Script...

) globalz.h

Compare Snapshoks. ..

Fegenerate Scripk...

ERCDIC Translation, .. F7

General Options. ..

P Recording Options. .. Chrl+F7 |
W
Cuskomize. ..

Compare ¥ML Files, ..

Recnrding Options |

—General: Recording

GUI Lewel
2 E  GUl-based script
. HTTP / HTHL Lewvel
- Port Mapping
~HTTF Properties & HTML-based script HTML Advanced... |

- ddvanced

Carrelation
" URL-based script URL Advanced... |

Advanced HTML

Scpt bype: 0k,

& A zeript describing user actions [e.g. web_link, web_submit_form) = :
anNCel
& script containing explicit URLs only (2.g. web_uil, web_submit_data)

Use Defaults

 f

Mon HTML-generated elements [e.g. JawaScrpt, WBScript, dctive, &pplets]

' Record within the current script step

" Record in separate steps and use concurent groups

Do not record

Hint:
towe the mouse over any item to zee itz dezcriphion.




Now that you are ready for recording Click on the record button

HP ¥irtual User Generator - [nonamel2 - Web (Click and Script}]

: Ele Edit Wew Insert  Yuser Ackions  Tools  Window  Help

Jv|gv| (@ StartRecord | B WO I1 €53 | s |gb Gl

Start Page | nonamelZ - Web (Click a

inty |

Start recording wour application {Ckrl+

@ vuszer_init 7 Ty

& Actien return 0
@ vuzer_end gl |

| globals.h

Give the Url of the application that needs to be load tested like the one below

Start Recording

i

Application type : Ilnternet Applications

— «

Frogram to record : IMicrnsc\ft Internet Explarer ;I I
URL Address : Ihttp:.-".-"'l 27.0.0.1:10280Meb T ourss LI
Working directon II::'*-.F'ngram Filez\MercurnyhLoadF unnertbin® LI I
Fecaord inta Action: I.-'l'q.c:tinn [% LI Mew. .

I Record the application startup

Options. .. |

Ok I Cancel I

The following table describes the criteria for determining the businessdnsar processes to

be included while recording

High frequency transactions

The most frequently used transactions have the potent
impact the performance of all of the other transactions
they are not efficient.

Mission Critical transactions

The more important transactions that facilitate the core
objectives of the system should be included, as failure
under load of these transactions has, by definition, the
greatest impact.

Read Transactions

ial to
if

At least one READ ONLY transaction should be included,

so that performance of such transactions can be
differentiated from other more complex transactions.

Update Transactions

At least one update transaction should be included g

o that



performance of such transactions can be differentiated
from other transactions.

Now record the transaction in either Vuser_init or Vuser_end or action by usingdheimg
tool bar.

Recording... {25 events).
& » W I | Acion = b Bl 3 5 P

Once the recording is over a recording log is also generated

To view a log of the messages that were issued during recording, click the Recaglitadp L
You can set the level of detail for this log in the advanced tab of the Recording options.

| |¥] Replay Log || E] Bacaidng Lag | T2 Canelaion Reeks | i Gensralian Log |

lvzex { 7el. 3d4:] Raquast Connection. Remote Servsr @ 152,163 [a

[ Jel: 1cdh] T
lyzex { J=0 1c=d4)] ﬁ_S:Ld. 1y Client —3 Server @ 554 bytes (_E'-e—l
lvzex § 7el. 1c4)] (5id. 1) Server —: Client : 2920 bhyvtez |
lyzmex [ Vel dod)] (51d: L) Server —r Client : 643 Bwtes (S

{ 7el: 1=d)] "GET <Inage? git'
lvzex [ Yol 1=40] (51d: 1) Client —: Sarwver : 590 bwtes (5=
Ivzex ([ Jel: 1o4)] (5id: L) Server —r Client : 2920 bytez
lyzex | J=0: 1c=d) {Sad 1y Server —> Client 2931 byte=s o
lyzexr [ 7el: 7d48)] Address lookup for us update. Dt:u'ma.umn rahoo
lyzex [ Jel: 7d48)] Addre=ss Lookup for magrit = 212 199 9106
lyze:l.' { =0 8 Ruquust Connection: Kenoke Ssce=rc 0 BE. 94 .23

4

lvzer 7el: 7401) Addres= loockup for cig. mywebsearch. com = 63 %

(= | 5

Now the script will be generated for the recorded user actions and will baydidpike this

Start Page | noname12 - Web (Click and Script) |
@@ vusenr_init Action()

@ Action i

@ vuzer_end =l web_url ("WebTours”

) globals.h "URL=http:~-127.0.0.1:1080/WebTours "
"Resource=0"
RecCDntBntType’text/html .
"Referer=

"Snapshot = t1 . inf"

"Mode=HTHL"

[% LAST):

lr_think time{l4):

= web_subnit_form("login. pl".

"Snapshot=t2 . inf",

ITEHDATA,

"Hamne=usernams". "Valus=jojo". ENDITEM.
"Hane=password". "Walu=s=besan"., EHNDITEHM.
"Hamne=login =", "Values=47", ENDITEHM.
"Hame=login.v". "Valu=s=5", ENDITEM,
LasT):

= web_image("SignOif Button".
"Alt=SignOff Button".
"Snapshot=t3 inf",
LAST):

return 0

1

[w] Replay Lag ||@ Recording Log | Generation Log

[Hetwork Analyzer { 470: 1bco)]
[Hetwork Analyzer ( 470: 1bc)] Load Hetwork Traffic Analyzers:

[Hetwork Analyzer ( 470: 1bc)] Analyzer Hodule: WPLUS (walue=)

[Hetworl Analyzer ( 470: 1bco)] Analyzer Module: WebBase (walus=GetHttpProtocolAnalyzer: api_http filter.dll)
[Hetworl Analvzer { 470: 1lbco)] + Hetworl Analyzer: api_http filter.dll @ GetHttpProtocolinslyzer Loaded!
[Hetwork Analyzer { 470: 1bco)] + Interception Auditors: WinlnetWpluslnterceptionAudit api_http_filter.dl1l
[Hetwork Analvzer ( 470: 1lbc)] Analvzer MHodule: WebUI (walue=)

[Hetwork Analyzer ( 470: 1bc)] Analyzer Hodule: WebldS (walue=)

[Hetwork Analwvzer | 470: 1lbc)] Analyzer Module: local_serwver (wvalues=)

[Hetworl Analyzer ( 470: 1bco)]




The above one is called the Script view. It can also be viewed as Tree view

Tree view:

Start Page | noname12 - Web (Click and Script) |
Action -

E--Q Action(] Recording Snapshot

B3 Uil WebTous
L Thirk Time - 14 (sec) ﬁ
3‘@ Submit Form: login. pl [ ]
H] Image: SignOff Button ﬁ WEbTOU rs

Ly

IPage Wiew | Client Request | Server Response |

Username

Password We b TO u rs
Welcome to the Web Tours site.

To make reservations, please enter your account information to the left.

If you haven't registered yet, sign up now to get access 1o all our resources,

Lo
=40 To configure the server options, use administration link.
Tree View I Thumbnallsl
IB Replay Log | I @ Recording Log | Generation Log
[Hetwork Analyzer ( 470: 1lbc)]
[Hetwork Analyzer ( 470: 1bc)] Load Hetwork Traffic Analyzers:
[Hetwork Anslwvzer ( 470: 1lbco)] Analyzer Hodule: WPLUS (wvalus=)
[Hetwork Analyzer ( 470: 1bc)] Analyzer Hodule: WebBase (value=GetHttpProtocolidnalyzer:api_http filter . dll)}
[Hetworlk Ansalyzer ( 470: 1bco)] + Hetwork Analyzer: api_http filter.dll @ GetHttpProtocolinalyzer Loaded!
[Hetwork Analyzer ( 470: 1lbc)] + Interception Auditors: WinlnetWplusInterceptiondudit:api_http_filter.dll
[Hetwork Analyzer ( 470: 1bc)] Analyzer Hodule: WebUI (values=)
[Hetworlk Ansalyzer ( 470: 1bco)] Analyzer Hodule: WebJS (value=)
[Hetwork Analyzer ( 470: 1lbc)] Analyzer Module: local_server (value=)
[Netvork dnalyzer ( 470° 1b=)] ——

The Next step is enhance the script
This includes

1) Inserting Transaction statements
2) Log messages

3) Comments

4) Inserting Functions

5) Performing Correlation

6) Parameterize

7) Inserting Rendezvous Points

8) Doing some run time settings.

To Insert Inserting Transaction statements Log messages, Comments)griaamnctions



?_@@ HP Yirtual User Generator - [nonamel2 - Web (Click and 59

 File Edit View | Insert | Yuser Actions  Tools  Window  F
[ =] = ~ | [4 =" MewStep.. Alt+Insert  fog
Start Pags | nonam |.,L) Start Transaction... Chrl+T
& vuser_init | End Transaction Chrl4D
@ Action +7+ Rendezvous...
@@ vuzer_end =3 Comment... M=t
[+ globals. b hti
| Log Message. .. I\:. lix-c
L i
! Mews Parameter. .. a1
<P> = e
<l Toggle Breakpaoint F2 =H

Now you need to perform Correlation in the script. The purpose of Correlation is

To simplify or optimize your code

For example, if you perform a series of dependent queries one after another, your code may
become very long. To reduce the size of the code, you can nest the queries, but then you lose
precision and the code becomes complex and difficult to understand. Correlatingetine 1sts
enables you to link queries without nesting.

To generate dynamic data

Many applications and Web sites identify a session by the current date and yimetrif to

replay a script, it will fail because the current time is different thanett@rded time. Correlating
the data enables you to save the dynamic data and use it throughout the scenario run.

The main steps in correlating a script are:

1 After Running the script once click on can for correlation button

;@ HP ¥irtual User Generator - [n

File Edit Wew Insert “user Actions Tools ‘Window Help

G-~ E @ statrecod b BN | 15 Gl P G Tesks |[Efsmnt | 7 e |[H]] [F E(E @Ij e
Start Page | noname12 - Web (Click and Script) | by
# vuser_init | |1}ct ion()

:JLCIII Scripk For Correlations {Chrl+Fa) '=

2 Determine which value to correlate.

For most protocols, you can view the problematic statements in tleaittbrelog. You double-
click an error message and jump directly to its location. Altesglgt, you can use the WDiff
utility distributed with VuGen to determine the inconsistenaighin your script. For more
information, see

3 Save the results.
You save the value of a query to a variable using the appropriate function. Theiogrrela

functions are protocol-specific. Correlation function names usually containitige str
save_param, such as web_reg_save param and Irs_save_param. Refer to thprepeoiiic



chapters for an explanation on how to perform correlation. In several protocols, suclbasedata
and Web, VuGen automatically inserts the functions into your script.

4 Reference the saved values.

Replace the constants in the query or statement with the saved variables

Now you can Insert Parameterization Statements
Steps for parameterization:

Locate the argument you want to parameterize
Give the parameter a name

Select a parameter type

Define properties for the parameter type
Replace the argument with a parameter

N o A N I N L B [Ny e N

weh submit_formi"login.pl”,
"Snapzhot=t:? . inf",

ITEHDATA,

"Hame=uzernan=", "Value=-jEirE_CHOLTTTH

"Hame=pa=zsword", "Valus=besa 7 Undo Chrl+Z

"Hame=login. x", "Valus=47",

"Hame=login.v". "Valu==Lt", cuk Chels

LAST) £ -

of Copy kel

weh _image( "SignQff Button', I

"41t=Sign0Off Button", | Paste Chrl+

"Snapzhot=t3. inf",

LAST Go ko Line. .. Chrl+ia
return 0 Go ko Step in Replay Log Chrl+E

Insert +

e Al Toggle Breakpoint Fa

Open Scripk Directory

v 9.0.0 for WIN2000: WebReplayd?

- =P . Feplace with alkernative navigation |
acumenhts and SettingssAdministra

Replace with a Parameter

i

W
Scan For Correlations (at Cursor) Alt+FS

urce “http:soL127.0.0.1:1080-Weh

ource "http:--127.0.0.1:1080-Teh Expand J Collapse r
Attt 2127 000 11080 A TTaRT e o a




Once you click like the above one you need to give the name for the parameter as in below one

Select or Cieate Parameler

Then Select a parameter type.
Define properties for the parameter type.
Replace the argument with the parameter.

Once you do it the parameterization window will look like this.

Jion Tayhor
Euob Smith

B {Carme [
| =

Uriqua
Each iherarion

Coniire wih | vaus

Now you can insert rendezvous point in the script

When performing load testing, you need to emulate heavy user load on your.system
accomplish this, you synchronize Vusers to perform a task at exhetlyame moment. You
configure multiple Vusers to act simultaneously by creatingnaezvous poinWhen a Vuser
arrives at the rendezvous point, it waits until all Vusemigpating in the rendezvous arrive.
When the designated number of Vusers arrive, the Vusers are released.



To insert a rendezvous point:

1 While recording a Vuser script, click the Rendezvous button on the
Recording toolbar, The Rendezvous dialog box opens.

r: Hrll'll'h"'i'l s

2 Type a name for the rendezvous point in the Rendezvous Name box.

Mote: The name for the rendezvous point is not case sensitive. For example,
the Vuser recognizes Rendezvous'| and rendezvous as the same point.

Click OK. VuGen inserts Ir_rendezvous into the Vuser script. For example,
the following function defines a rendezvous point named rendezvous]:

Ir_rendezvous("rendezvous1™);

3 To insert rendezvous points into your script after the recording session,
select Insert > Rendezvous from the VuGen toolbar.

Now you can set the run time settings



Run-time Settings ll
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Now we can run the script in stand alone mode to check if the scripts are runningyproperl
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Once the scripts are running fine in stand alone mode , thests s@rpbe placed in
for funning the load test.

controller



Controller

To open the Controller:
You can open the Controller by choosing either of the following:
Start > Programs > LoadRunner > Applications > Controller.
Start > Programs > LoadRunner > LoadRunner. The HP LoadRunner

launcher window opens. Select the Load Testing tab, and then click Run
Load Tests.

If the New Scenario dialog box does not open on startup, you can open it by
choosing File > New or by clicking the New button on the Controller
toolbar.
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Once the Scenario is opened we can do the following

1) Controlling the number of Virtual Users

2) Setting up the SLA

3) Define the group name, Vuser quantity, load generators, and scripts for thegkusger
4) Add and configure one or more scripts to the Vuser group

5) Enable or disable a Vuser group for the scenario

6) Remove a Vuser group from the scenario

7) Setting up the Run Duration

8) Setting up Load generators

9) Defining the run pattern by using Ramp up and ramp down



Selecting the Scenario Type
Select one of the following scenario options:

Manual Scenario. Select this method if you want to build a maneatso. You build a manual
scenario by creating groups and specifying the script, the load generatdheandmber of
Vusers included in each group.

Use the Percentage Mode to distribute the Vusers among thbess&elect this option if you
want to build a manual scenario by specifying a number of Vusersdstobuted among the
selected Vuser scripts.

Goal Oriented Scenario. Select this method to have LoadRunner lagkhario for you. In a
goal-oriented scenario, you define the goals you want your test to gchrevd.oadRunner
automatically builds a scenario for you, based on these goals.

To create Vuser Groups:

T On the Scenario Groups pane toolbar, click the Add Group button. The Add
Group dialog box opens:

Lo resiz

2 In the Group Name box, enter a name for the Vuser group.

3 From the Vuser Quantity box, select the number of Vusers that yvou want to
create in the group.

Creating Load Generators



Select a load generator from the Load Generator Name list. To use a load
generator that does not appear, select Add from the Load Generator Name
list. The Add New Load Generator dialog box opens:
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Type the name of the load generator in the Name box. In the Platform box,
select the type of platform on which the load generator is running,

Defining SLA:

An SLA is a formally negotiated agreement between two partigs. dt contract that exists
between customers and their service provider, client or betweenespreviders. It records the
common understanding about services, priorities, responsibilgeatantee, and such —
collectively, thelevel of service For example, it may specify the levels of availability,
serviceability, performance, operation, or other attributes of thacselike billing and even
penalties in the case of violation of the SLA.

About Defining Service Level Agreements

When you design a load test scenario, you can define goals or semgtagreements (SLAS)
for the performance metrics. When you run the scenario, LoadRunner sgatmerstores
performance-related data. When you analyze the run, Analysis contp&remta against the
SLAs and determines SLA statuses for the defined measurements.

Depending on the measurements that you are evaluating, LoadRunner
Determines SLA statuses in one of the following ways:

SLA status determined per time interval within the run. Analgg@plays SLA statuses at set
time intervals—for example, every 10 seconds—over a timeline within the run.

SLA status determined over the whole run. Analysis displaysgéesSLA status for the whole
scenario run.



To define an 5LA for Average Transaction Response Time:
Open the Service Lewvel Agreement Wizard.

» If you are working in Analysis: Select Tools > Configure SLA Rules to open
the Service Lewvel Agreement dialog box. Click New.

» If you are working in the Controller: In the Design tab, in the Service
Level Agreement pane, click New.

The Service Level Agreement wizard opens.

Complete the 5LA Wizard steps, as described in the following sections.

Measurement—S3Select a Measurement for Your Goal
For Average Transaction Response Time, LoadRunner evaluates SLA statuses
at set time intervals within the run.

Under SLA status determined per time interval within the run, select
Average Transaction Response Time.

Transactions—Select Transactions

From the Available Transactions list, select the transactions that you want to
evaluate as part of your 5LA and click Add.

Mote: You can select multiple transactions using the CTRL key.

The transactions you selected are displaved in the Selected Transactions list.

Load Criteria—5et Load Criteria

Select load criteria for yvour goal and define appropriate load value ranges.






Running the Scenario
The following procedure outlines how to run a scenario:

Open an existing scenario or create a new one.
Configure and schedule the scenario.

Set the results directory.

Run and monitor the scenario.



And once you run the scenario you will get the details like this



Graph Analysis:

During load test scenario execution, Vusers generate result dathewsperform their
transactions. The Analysis graphs help you determine system panemand provide
information about transactions and Vusers. You can compare multggbdsgby combining
results from several load test scenarios or merging several graphs into one.

The Report utilities enable you to view a Summary HTML reporetwh graph or a variety of
Performance and Activity reports. You can create a report asr@ddit Word document, which
automatically summarizes and displays the test’s significant dataphigghand tabular format.

Analysis graphs are divided into the following categories:

Vuser Graphs. Provide information about Vuser states and other Vuser statistics
Error Graphs. Provide information about the errors that occurred during the load
test scenario.

Transaction Graphs. Provide information about transaction performance and
response time.

Web Resource Graphs. Provide information about the throughput, hits per second,
HTTP responses per second, number of retries per second, and downloaded pages
per second for Web Vusers.

Web Page Diagnostics Graphs. Provide information about the size and download
time of each Web page component.

System Resource Graphs. Provide statistics relating to the system refimatrces
were monitored during the load test scenario using the online monitor.

Starting Analysis

You can open Analysis as an independent applicatiodirectly from the Controller. To open Analysis an
independent application, choose one of the follgwin

Start > Programs > LoadRunner > Applications > Asial
Start > Programs > LoadRunner > LoadRunner, stiedtoad Testing tab, and then click
Analyze Load Tests.



Once you start the Session a Summary report will be displayed
Summary Report:

The Summary report provides general information about load test scenario exedusiorport
is always available from the Session Explorer or as a tab in the Anmalyglow. The Summary
report lists statistics about the scenario run and provides links

to the following graphs: Running Vusers, Throughput, Hits Per Second, HTTP Responses per
Second, Transaction Summary, and Average Transaction Response Time. The appedmance of t
Summary report and the information displayed will vary depending on whether an Sk&kéSer
Level Agreement) was defined. An SLA defines goals for the scenario. LoadRunneregseas
these goals during the scenario run and analyzes them in the Summary report.

This Summary Report will have the following details:

Transaction Summary

This section displays a table containing the load test sce&ndramnosticslata. Included in this
data is a percentile column (x Percent). This columdicates the maximum response time for
that percentage of transactiomsrformed during the run. For example, in the table below, the
value in the88 Percent column for browse special books is 8.072. This means thespbease
time for 88% of the browse special books transactions was less8th@2eseconds.

Scenario Behavior over Time

This section displays the average errors per second received bppheation under test per
time interval. For example, 0 means that on average there wererzers received per second
for that time interval, 0+ means that on average there wegbtlglimore than zero errors
received, and so on.



HTTP Responses Summary

This section shows the number of HTTP status coetesned from the Weberver during the load test scenario,
grouped by status code.

X Worst Transaction

The X Worst Transactions table shows the worsstations in terms dfow often the transactions exceeded the
SLA boundary during the run, afy how much.

SLA Report

An SLA (Service Level Agreement) defines goals for the load test scenartRuoaer
measures these goals during the scenario run and analyzes them in the SummaihesfaA
Report shows the succeeded or failed status of all SLAs that were defineddoeniaeo run.



The Following are the other Graphs that are Displayed

Transaction Response Time under Load

Displays average transaction response times relative to thieenwwhVusers running at
any given point during the load test. This graph helps you view the tém@act of
Vuser load on performance time and is most useful when analyzoapdadst which is
run with a gradual load.

Hits Per Second Graph

Displays the number of hits made on the Web server by Vusers duringexand of the
load test. This graph helps you evaluate the amount of load Vusersaigenn terms of
the number of hits.



Running Vusers Graph

Displays the number of Vusers that executed Vuser scripts, andttdtes, during each
second of a load test. This graph is useful for determining the Yas&on your server
at any given moment.

Average Transaction Response Time

Displays the average time taken to perform transactions duritgseaond of the load
test. This graph helps you determine whether the performance of tlee Eemithin
acceptable minimum and maximum transaction performance timesrdefjeed for your
system.



Hits per Second

Displays the number of hits made on the Web server by Vusers duringezaand of the
load test. This graph helps you evaluate the amount of load Vusenrsaigenn terms of
the number of hits.

Throughput

Displays the amount of throughput (in bytes) on the Web server during theelsia

Throughput represents the amount of data that the Vusers receiveth&server at any
given second. This graph helps you to evaluate the amount of load geserste, in

terms of server throughput.



Transaction Summary

Displays the number of transactions that passed, failed, stopped, or ended wgth erro

Average Transaction Response Time

Displays the average time taken to perform transactions duritgseaond of the load
test. This graph helps you determine whether the performance of tlee Eemithin
acceptable minimum and maximum transaction performance timesrdefjeed for your
system.



Page Component Breakdown

Displays the average download time (in seconds) for each Web page and its components.

Windows Resources
Displays a summary of the System Resources usage for each Windows based host.



Connections Per Second

Displays the number of Connections per Second

Downloaded Component Size (KB)

Displays the size of each Web page component. Note that the sptaydd includes
both the size of the component and its header.



Time to First Buffer Breakdown

Displays each Web page component’s relative server/network itinsz¢onds) for the
period of time until the first buffer is successfully received back from the s&ever.



